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Section 1. Address of Student Web Sites

All students have web site addresses.  The address for a student's web site is: 

http://www.ksg.harvard.edu/students/loginname
For example, if your last name is “Smith” and your first name is “John”.  Then your web site address is: www.ksg.harvard.edu/students/smithjo   

If I have not made my web page, what is on that page?  Before you load any web pages to your web site, your web site will contain a blank index page that says, Index of /~.Username.Students.Ksg/  This simply means that the web site can be there, but it is not yet loaded with active web pages.

Section 2. Making a web site.

Students must create their web sites in a software program designed to make HTML files (HTML= hypertext markup language.).  

· If you do not know how to create web sites, see Section 4.  

· If you want to post a web site to your student web address that you created using Front Page Explorer and Front Page Editor, See Section 5.  

· If you have already created a web site, and merely want to post it to your student web address, See Section 3.  

Some examples of software that you can use to make web sites are: Microsoft's FrontPage (available in KSG computer lab), Netscape's Composer, or Macromedia's Dreamweaver.  The advantage of Front Page—available in the lab—is that it allows you to manage your whole web site, and then edit your pages in a professional WYSIWIG editor.  (WYSIWIG = what you see is what you get).  Some of the other HTML editor software available is very limited (i.e. few features).  For example, you cannot edit easily using Netscape Communicator.  If you want to use other software (besides Frontpage) that is fine—but the KSG lab uses Front Page.  Front Page happens to be made by Microsoft—and so it has many features that are similar to the features in Word, Excel, Powerpoint, etc.

Front Page Editor
Edits one web page at a time.  Saves files in .htm format.  Operates an awful lot like Word, Excel, etc. and is easy to use.

Front Page Explorer
Manages a web site of many web pages.  Keeps track of all your .htm files as well as any photos or text attachments that are embedded in your web site.

Browser
Allows you to view your web site.  Examples are Netscape Communicator or Internet Explorer.  

Design Folder
When you make a web site, you want to keep a copy of the web site in a design folder.  You edit your files in a design folder, and when the design web site is looking good, you transfer or “publish” it to your “Web Site Folder”

Web Site Folder
When you have a web site, you publish it – make it live on the web--- by putting all the files into a web site folder.  As a student, your web site folder is M:\www.  However, if you want to publish a club or a pic web site, you will have to get the Information Technology (IT) department to tell you the address of the club’s web site folder.  Likewise, if you are publishing a web site for a department or a class, you will need to find the name of the server address to which you publish.  

Section 3.  Posting your already made web site.

Your web site may be one web page, or a large web site with many pages and other files.  Once you have a web site, then you are ready to post them to your  “Web Site Folder” in your personal directory.   Your “Web Site Folder” is called M:\www.  It holds your web site files.  If you already have a web site (comprised of many files) then you will merely transfer the whole site into the “www” folder.  The page called “index.htm” will appear as your home page.  

Step 1. All students have a file folder called “www” on their M:\ drive.

From the desktop, open My Computer.  Search for the M:\ directory.  
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Explanation of Step 1. This is your personal directory as a student.  [your M:\ is listed as loginname on ‘ksghome\students\private on M:]   One of the folders (yellow) should be called “www”.  If you do not have a M:\www directory, then you should create one.  Go to File\New\Folder, and then rename the folder that appears “New Folder” to be called “www”.  

Step 2.  Copy all web site files into your www directory.  A file by the name of “index.htm” must appear as one of the files in your M:\www folder—that file becomes your default home page.  Once your file transfer is complete, then your web page will be live.  See Section 1, to figure out the address of your new web site.    

The “index.htm”  file will be your "homepage".  It will appear first whenever anyone tries to visit your site.  All other web pages for your site can be listed according to name, and linked accordingly.  All files—including photos, text documents, etc.  must be in the www directory, or a subdirectory of www that you create and specify.

Alternate Step 2.  Uploading Files from Home.

If you are trying to post web site files into your M:\www directory from home, then try these directions.  It is probably far easier to just do the file transfer in the lab, but there are those of you who are brave.  Carry on.  Both options below require a minimal knowledge of FTP or File Transfer Protocol.   Incidently, you could use these same methods for uploading or downloading any file to and from other folders in your personal directory.
a. Using Netscape Navigator

In the URL box type in the following

ftp://.username.students.ksg@ksghome.harvard.edu//ksghome/students/private/username/www

Be sure to include the "." in your username they are critical.

After you hit return you will be prompted for your password. This password is the same one that you use to login to the KSG network. Now from the "File" menu select "upload file" and choose the file or files you wish to upload. Files transferred into the ksghome server can only be eight letters in file name.   (Repeat:  you must use eight.three names   letters8.htm  will work; however, letterseight.htm is too long of a name for ksghome to handle.)

Remember! You must have a file called index.html or index.htm in the M:/www directory.  This file will be your "homepage".  It will appear first whenever anyone tries to visit your site.  All other web pages for your site can be listed according to name, but they must be in the www directory, or a subdirectory you create and specify.

b. Using an FTP software program

FTP is File Transfer Protocol  It is software that is widely available for free from software shareware sites such as www.download.com or www.shareware.com.  You can go to either of these sites and find the latest version of FTP software.

If you are using WSFTP or Fetch here are the settings you would use:

Host: 

ksghome.harvard.edu

User: 

.username.students.ksg

Password: 
Your network password

Click on Connect.  If everything is correct, then you should get connected to your starting directory as:



//ksghome/students/private/username/

In order to upload files to your website, you need to load them to the "www" folder within your personal directory. When you are at school, this would be the M:/www directory.  For example if you are using WSFTP, then highlight the file from your home machine in the left column and then click into the correct directory on the right column, use the ( arrow to transfer the files.
Remember!  You must have a file called index.html or index.htm in the M:/www directory.  This file will be your "homepage".  It will appear first whenever anyone tries to visit your site.  All other web pages for your site can be listed according to name, but they must be in the www directory, or a subdirectory you create and specify.

Section 4.  Create A New Web Page Using Front Page 98 At School

Step 1. All students have a file folder called “www” on their M:\ drive.

From the desktop, open My Computer.  Search for the M:\ directory.  
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Explanation of Step 1. This is your personal directory as a student.  [your M:\ is listed as loginname on ‘ksghome\students\private on M:]   One of the folders (yellow) should be called “www”.  If you do not have a M:\www directory, then you should create one.  Go to File\New\Folder, and then rename the folder that appears “New Folder” to be called “www”.  

First, Open My Computer from the desktop.  Look in your personal files directory.  You should see a yellow file entitle “www”.  Open the “www” directory.  Make sure there are no files in this directory. 

Step 2. Delete any old files in your www directory. When you start making a Front Page Web, the M:\www file should be clean, i.e. empty.  

M:\www is your “Web Site Folder”.  Once there are files in the folder they will appear “live on the web”.  

Step 3. Launch FrontPage Explorer by going to the "Start" menu and finding the Microsoft FrontPage icon under "Programs".  

The first thing that appears is a "Getting Started" dialog box.
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Choose, Create a New Front Page Web.

If another box opens, you might need to hit Cancel. If you are facing a blank Front Page screen, select File/New/Front Page Web.  From here we can open existing FrontPage web sites and create new ones. Right now we will create a new web site.

Choose File/New/ Front Page Web.

Step 4. Change the location for the front page web.
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Under Number 1, You can see that there are a number of ready-to-use "wizards" that guide you through the creation of different types of sites, as well as the option to import an existing set of web pages into Front Page.  We have selected, From Wizard or Template/ "Personal Web".  This is the default, and we can leave it that way.  If you want to be really basic, choose the default to be One Page Web/ "Personal Web".

Under Number 2, Choose Change.  This is the feature that lets us choose where the files in our web site are designed.  We want to have a web design folder that is different from our live on the web folder.  We do not want to store our files in the same place that we post our files.  (We want our "live" web site to be a different set of files from our "creation" web site…. Heaven forbid a potential employer surf to your site while you are in the midst of editing your site!!)  You can call your web design folder anything you want-- -but in this case we are choosing M:\designweb.  Be very careful to use the backslash \    the key that is located above the Enter Key.  Choose Ok.
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Step 5. Check the Location
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On the line under #2, there should be a M:\designweb list.  Choose OK to make your new web.  
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The correct answer is Yes.  You will see Front Page Thinking for a second, and then you will see your new web site in all of its glory.

Step 6.  Explore Front Page Explorer

Front Page Explorer automatically sets you up with a Personal Web Site that contains four pages.  You will be able to add and subtract to these pages as much as you want, but they start you out with a template.  It should look like this:
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You have now created a web site.  This is the Front Page Explorer.  We can use this software to add and subtract new pages, as well as maintain and publish the site.  For more information on how to use Front Page Explorer, skip down to How to Use Front Page Explorer, page 9.  You can edit these files to your heart's content, but if you want them to appear on the web, you need to save all the files, and then Publish them according to the directions in the next section, "How to Publish your web site using Front Page Explorer".

Let's take a look at some of the feature of the FrontPage Explorer interface:

Views

Along the left side is the "Views" bar.  These seven buttons provide different ways of looking at your FrontPage web – 

The "Folders" button displays the files on your web site as they are organized in the file system of your web server - or in this case our local hard drive. This includes some folders that are created automatically by FrontPage. You'll see a folder called "_private" for example. It's similar to the two-panel display you get in the Windows 95 Explorer: the directory structure is on the left and the detailed list from the selected directory is on the right.

The "All Files" button displays all the files that you add to your web site in one long list. It's also similar to the Windows Explorer display, except that files aren't listed according to the directory organization. 

The "Navigation" button displays the top-level structure of your FrontPage web on the top half of the screen with a file and folder list below.  This is an organizational structure for your Front Page Web.  It shows you the “PARENT” and the “CHILD” pages.  The Home Page is the parent page, and the Favorites, Photo Album, and the Interests are the children pages.

The "Themes" button lets you apply a consistent graphical "look and feel" to your web site. FrontPage provides a great number of these pre-packaged themes; most of these are pretty awful to the naked eye, but they can be tolerated.  You might make them more palatable by choosing Background only (or just Vibrant Colors.)  You can customize a Theme, adding your own logo or photo by editing one of the banners on an individual web page.  The banners act like “Headers” and they appear on every page.

The "Hyperlinks" button displays the hyper-textual structure of your web site. The panel on the left is a top down view of the site in terms of the hyper links between documents: the top-level documents on the site are shown as the parents in an outline or tree display. The documents that they link to are displayed as children. The right hand panel displays the currently selected page with all of the documents that it links to, as well as all of those that link to it as indicated by the directional arrows.

The "Hyperlink Status" button displays any broken internal hyperlinks in your web site and lets you verify and repair any broken internal or external hyperlinks.

The "Tasks" button displays a list of automatically and manually generated tasks for the maintenance of your web site. Automatically generated tasks can include such things as correcting spelling errors and fixing broken hyperlinks. In a collaborative web design environment, tasks can be installed to individual authors.

Toolbars

Along the top of the Explorer is the Toolbar, which has icons that are short cuts to frequently used tasks. Below the toolbar is a title that corresponds to the view that you have selected in the Views bar.

· Add new pages to your FrontPage web

Starting with our home page, we're going to create a simple site consisting of four pages that are linked together. We will use the Navigation view to accomplish this task. Select any of our first pages, which were automatically created. You can always tell that a page is selected in the Navigation view because it will be displayed in blue. On the toolbar, I’ll click the New Page button.

This adds a new page labeled “New Page 1” below the home page in the Navigation panel.  You can click or drag the New Page to be a child of an existing page, or a sibling of existing pages.  

In the example below, Top Page 1 is a child page off of Interests.
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FrontPage prompts us to create navigation bars that will link our pages together. For this example we will click yes. Now we will add two more pages using the New Page button. The Navigation page displays the hyperlinks in your web site as a hierarchical structure. This is the structure that FrontPage uses to create the navigational links on your pages, but you can also leave the navigation bars out of you web site altogether.

· Add titles to pages

Let’s add some meaningful titles to the new pages that we’ve just added to our web site. Click once on the page to make it blue.  Use the Right Click button on the Mouse and Choose, Rename.  You should see a blinking cursor in the box.  Type a new name for the Box, and then hit enter.  The names you choose as page titles will appear in the banner of each page.  You might want to rename the homepage “Sarah’s Home Page”  There is a limit to the number of characters that will fit in a banner, although I don’t know what the limit is…..

Step 7.  Edit Web Pages

Once you have become familiar with Front Page Explorer, you will want to use another software program called Front Page Editor to edit individual pages.   If you click on one page in your web site, then FrontPage Editor automatically opens.  For Example, To open our Home page in Front Page Editor from the Navigation view we just double click on the page icon. We can also open pages by selecting Open in FrontPage’s Edit menu. [Note: We are now opening another piece of software, this one is called, Front Page Editor, and it lets you edit web pages, one page at a time.]

While creating pages and managing files is best handled in the FrontPage Explorer, designing and editing pages is done in the FrontPage Editor. If you have used Microsoft Word the Front Page Editor’s interface (interface = “look and feel” = features) will be very familiar. This is Microsoft FrontPage’s WYSIWYG (What you see is what you get) interface for HTML editing. While you create pages using this interface, you can also view and directly edit the HTML source code and also preview your pages in any web browser you have installed.  

Note the page title that has already been added to the Home page by FrontPage. Any changes you make in the Navigation window will be reflected on your pages the next time that you open the web page.

· Add text to the home page

You can add text to your home page by beginning to type, just as you would in a word processor. I’ll just type a greeting: “Welcome to my web site!” When I press ENTER, a new paragraph is created – some white space is added before the beginning of the new line. If I just wanted to add a line without automatically double spacing (extra line break) – I would type SHIFT-ENTER. Now I will add some more text…. And then I notice that I can edit the text by using the tool bars at the top of the page.  The bottom most tool bar, allows you to edit Styles, Fonts, Font Size, Bold, Italics, Underline, Font Color, Left Justify, Center Justify, Right Justify, Bullet, Number…. Have fun.  Go crazy.   Just highlight the text, and choose the feature that you want.  Just like in Word or Excel.

Remember: When you choose your text color you probably don’t want to choose Blue because blue usually signals to people that you are creating a hyperlink.
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· Saving the current page

It’s always a good idea to save your work before going on. From the Editor’s File menu, select Save as( This dialog box gives us a number of options concerning where and how we save our new web page, but for now we’re going to keep it on our personal director at M:\webdesign, so we’ll just click OK.  You could also just click on the little “disk” icon at the tool bar.

· Opening a page in the FrontPage Editor

Now let’s open the page titled “Interests” (or some other title, it doesn't matter…) in the FrontPage Editor by selecting Open from the File menu. The Open file dialog box displays the pages and folders in you FrontPage Web. You can also use it to open files elsewhere in your local file system or from another web server. Right now I’ll select interest.htm and click OK to open the Interests page.

Note again that the navigation elements we saw on the Home page have also been added to this page as appropriate.

· Adding a bulleted list

The FrontPage Editor supports the quick creation of bulleted lists. I’m going to add a short list of activities and hobbies. First you click the Bulleted List button. Your first bullet appears on a new line. As you type each item (type “Water skiing”) and press enter the next bullet appears on a new line (type “Snow”. By pressing ENTER twice we end the current list. Note that you can use the numbered list button to create numbered lists.

· Copying and pasting text

If you left out the word “skiing” from the second item in your list, fortunately you can copy and paste text in the editor exactly as you would in Word. I’ll select the word “skiing” from the first item and then select Copy from the Edit menu. Moving the cursor down to the second item, select Edit again, and then Paste. Of course you can also use keyboard shortcuts to edit text; for example CTRL+c to copy and CTRL+v to paste.

Save the Interests page and open the Photo Album page for editing. We can press the save button, or CTRL+s to save

· Importing images

Go back to Front Page Explorer.  Click on the Photo Album Page to open it in FrontPage Editor.  Alternatively, I’ll open the Photo Album page we created earlier by selecting File/Open and then selecting photo.htm and clicking OK. Again I’ll add some text at the top of the page: “Here are some photographs that came with the FrontPage Clip Gallery.” 

You might just want to delete the images that come with the FrontPage Personal Web template.  Just highlight the image with your cursor and hit Delete.  Bye-Bye ugly image of a sunset.  

From the Insert menu, I choose Image and the Image dialog box is displayed.  You can also use the little yellow button on the second tool bar—it has a little image of a sun with two mountains.  In any case, you get the following Dialog Box:
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Now, you have two options.  You can either choose an image that is listed in the web (these images are already in your M:\webdesign folder) or you can go out to your hard drive and get some other image.

Click on the Yellow folder with the Magnifying Glass in the bottom right hand corner.  This option is called “select a file on your computer”
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Then you are free to search through your files on your hard drive and  select ok.  You can use any “.jpg” or “bmp” or “.gif” file.  These are just names of different kinds of image formats.

When you select the image and say ok, it will appear on your page.  To edit the image, click on the image, using the little white handles in the corner, expand or contract the image.  Using the right mouse click you can edit other Image Properties.

Now would be a good time to save our work. Notice that when I click the Save button the Save Embedded Files dialog appears. This asks me if I want to keep copies of the image files that I’ve just added to the Photo Album page with the rest of the files in our current web. Usually, you do want to do this. So I’ll click OK.  This is one of the reasons FrontPage Explorer is so handy, it keeps track of all your pages, and your embedded files…. Keeps everything together, neat and tidy. Ho-hum.

· Creating hyperlinks from text

1. Open the "Favorites" page for editing.  Delete the text that comes as default.

2. Type some text: “I like to read the Boston Paper”

3. Click and drag over the text just typed to highlight the words Boston Paper

4. On the Insert menu select Hyperlink.

There are six ways to create Hyperlinks—

a. you can select another page in your web site

b. you can type in the URL (URL= universal resource locator = web site address)

c. you can search the web and create a verified hyperlink

d. you can search in your files for a document to link to

e. you can create a hyperlink to an email address

f. you can create a hyperlink to a new page

Each of these options is accessible via the Create Hyperlink Dialog box.
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The Create Hyperlink dialog appears. In the URL field type the URL: http://www.boston.com. Click OK.  (You can choose any web address you want, but www.boston.com is the Boston Globe.

6. All you have to do is say ok.  Notice that “Boston Paper” is now underlined and in blue.  The hyperlink status is confirmed when you hold the cursor over the link, and the address appears in the bottom left hand corner.

· Creating an automatic hyperlink

1. Type a URL: http://www.hotbot.com and press Enter.

2. The URL becomes an active link. Click and drag to select it.

3. Now type the name of the site: Yahoo! The text changes but the active link remains.

· Creating a verified hyperlink

1. Press the down arrow to go to the next line. 

2. Type the name of the web site: Microsoft FrontPage and press enter.

3. Select the text you just typed.

4. In the Insert menu choose Hyperlink.

5. In the Create Hyperlink dialog box click the World Wide Web button.

6. This launches your web browser. By surfing to the page that you want to use and then switching back to FrontPage Editor (choose it from the boxes at the bottom or your screen or by switching between active software programs with  ALT+TAB).  FrontPage Editor was watching you surf, and the address of the selected page will appear in the URL field.

· Creating a hyperlink to an email address

You can just type an email address like john@bignameschool.edu and hit ENTER

And then the text will automatically appear as a hyperlink (underline and in blue).  Or you can write some text like “Send me an email” and then highlight text, choose Insert, and then choose the little yellow envelope to the right of the URL line… this gives you the option to create and 

Email hyperlink.  

In this example, we have typed in the email address as john@smith.com.
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· Previewing your home page in a web browser

There are two ways to preview you FrontPage web in a web browser:

1. In the File menu choose Preview in Browser.

2. Alternatively, you can preview your page by using the “Preview” tab at the bottom of the web page.

· Previewing your page in an HTML format.

For those of you who really want to see the HTML, there is an HTML tab at the bottom left hand corner of the screen.  FrontPage Editor has been creating the HTML, but you can go and edit it or view it by hitting the HTML view (it looks like a file folder tab).  This is sometimes helpful to check if you have a little bug in your page.

· Creating a Hyperlink to a document.

To create a hyperlink to a document, you need to have patience and perseverance.  And a little faith will help…..

1. Import the Document into your front page web.

From Front Page Explorer, Choose File, Import
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2.  Select Add File.  And choose the file from your list of files.
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3. You will just choose this from your file list.  The default “bin” directory pops up; and if you click in the white space to the right of the word “bin” you will automatically be able to skip over to your M: drive.  Anyway, select the file and choose Open.

4.  Now the file appears in a list.
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5. You select OK.  Now the File appears in your list of files on the web. By the way, you can import text files, excel files, acrobat files, whatever.

 Now the tricky part.

6. Web sites only like files with eight letter names.  RENAME your file something with eight letters.  You can click on the file (make it blue) and then Right Click it and choose Rename, then rename the file something only eight letters long.

7. Now Click Back over to the relevant page in FrontPage Editor.

Type some text, like, check out this file.  Highlight the Text, choose Insert\Hyperlink.  Then from the list of files, select your file.  You may have to change the directory that the computer is looking in for files, make sure that the computer is looking for files in M:\webdesign.  At the top of the dialog box there is a little box that says : Look in: M:\webdesign   should appear there.  If not use the little black arrow to get the box to pull down and then select M:\webdesign.

8. Choose Ok.
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Section 5. How to Publish your web site using Front Page Explorer

1. Save Files.  You should save all of the files you have changed in your web design directory (Remember we called it M:\webdesign). You do this by hitting Save on each page while in editor.

2. When you are in Front Page Explorer, choose File\Publish Front Page Web.
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3. A dialog box appears and asks you to where do you want to publish the web site.  You should always select:



More Webs

4. And then make sure you are publishing to: 
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Say Ok.  A little box might appear to ask you if you want to convert the folder to a front page web, and you say ok.  Then you will be able to see front page Explorer working hard to transfer a copy of M:\webdesign into M:\www.  Once FrontPage Explorer has finished publishing, then you can check your web site on the internet.  www.ksg.harvard.edu/students/login   Notice that your web page address automatically jumps to something like: http://ksghome.harvard.edu/~.TirpakM.Students.Ksg/
You want to give out the first address, not the address that includes ksghome.harvard.edu

Common Problems:

1. You forgot to save your page.

2. Your login name is more than 7 letters long, in which case you need to contact Aileen Grunder (IT Department) to fix the problem of where your web site directs. (She’ll understand….)

3. You saved your page, published, and went back to check the changes…. Hit Reload in order to view the changes.

4. You tried to create web pages or attach files that have more than eight letter names.  The Kennedy School web site server does not tolerate file names over eight letters long. 

5. You did not publish to M:\www  -- always double check the location.

One more thing, To Reopen web site, you choose 

Open\Front Page Web  Choose Open and Existing Web, and then go to More Webs.

You will always need to click on List Webs.  And then your web page, with your name should appear.  Remember you want to open your DESIGN WEB not your M:\www.

So make sure that the Select a Web server or disk Location is pointed to M:\designweb (or what ever your design web is called).  You might have to use the little pull down arrow.

Once your web appears, you can click ok and it should open.

Follow the following Steps over and over and over and over.  Repeat as necessary until everything is perfect.

TASK
SOFTWARE

1. Edit Web Page
Front Page Editor

2. Save Web Page
Front Page Editor

3. Publish Web Site
Front Page Explorer

4. View Changes
Browser (Netscape Navigator or Internet Explorer). HIT RELOAD.

Good luck.  There are a few copies of Front Page for Dummies available at the computer lab front desk.

Section 6. Useful Web Lingo

http://www.netlingo.com/

Dictionary of computer and internet terminology.

For all those web words that you don’t know!

Browser
Software that let’s you view web sites (Netscape Navigator or Internet Explorer)

Front Page
Microsoft’s Brand name for web site software.  

Front Page Editor
Software that let’s you edit one web page at a time

Front Page Explorer
Software that let’s you manage a whole web site

HTML
Hypertext Markup Language. Also known as Code.  This is sort of like Word Perfect Reveal Codes (Remember that???)

Interface
The system by which the software interacts with the software user

URL
Universal Resource Locator, fancy for web site address

Web Page
One single web page

Web Site
Many pages linked together in glorious harmony.

WYSIWIG
What You See Is What You Get.  It refers to the fact that when you create a web page using an editor, the editor automatically writes the HTML code for you.
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